WaplDE 3.1

User’'s Guide

.
=

Fila Edd View Tools Help
D@ @@ «~ i maprRiomg

2 walto wl-c:unumil
<1 [ weelcome wmil f
B D) carndfivapiDE 3.1) <renl LTI
=qH < 'DOCTYFE o # UAP FORIS /T
LR “hETp: e wap
img Cumll
LR E “oard “aplDE 2. 17k
i Bb <p "CERERL ">
L Cimg 'epdcason_logo. whap '
~HR b <ExWapIDE 3. 0</be
A la ChiE Sl 'Fgeceuaya” Cace
» LM CBESE 'Flinka' >Linka</
) % g 2 g
5] E] .
* it < S OEd
" '-l_:ll'.‘anlllll}m | wcard Tilrabeuays™ "gatewny

hIE'.I'I'CI RS S ISR ¢ 0wl

K WaplDE 3.1
ERICSSON 2 wiapine 3.1
Cabgeins
Linkg

B MOTEMEE

LLes it b

http://www.ericsson.com/developerszone

E RICSSO N ’ Version April 9, 2001

\\



Ericsson is the leading provider in the new telecom world, with communication
solutions that combine telecom and datacom technologies with freedom of mobility
for the user. With more than 100,000 employees in 140 countries, Ericsson
simplifies communications for its customer — network operator, service providers,
enterprises and consumers — the world over.

WAP™ and WAP Forum™ are registered trademarks of Wireless Application
Protocol Forum, Ltd., a registered company in the United Kingdom.

Java™ and JDK™ are registered trademarks of Sun Microsystems, Inc. in the
United States and other countries.

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft
Corporation in the United States and/or other countries.

Adobe® and Acrobat® Reader™ are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.

This product includes software developed by the Apache Software Foundation
(http://www.apache.org/).

First edition (April 2001)

This document is published by Ericsson Radio Systems AB, without any warranty.
Improvements and changes to this text necessitated by typographical errors,
inaccuracies of current information or improvements to programs and/or equipment,
may be made by Ericsson Radio Systems AB at any time and without notice. Such
changes will, however, be incorporated into new editions of this document.
Reproduction, distribution or transmission of part of or all of this document in any
form without the prior written permission from Ericsson Radio Systems AB is
prohibited.

All rights reserved.
© Ericsson Internet Applications AB, 2001



Contents

Introduction 6
Purpose and scope of the USer’s GUIAE........ccveruieriieriieiieieeiece e 6
WHho 1S this UIAE FOI? .....iiiieieiiecie ettt 6
Related documents and Other TESOUICES.........coueverueririeiiieniiericeieeeeetet e 6

Related INEINEt SIEES. ....c.veteiiriirtiriiriirieeitet ettt ettt 6
Related dOCUMENLS ....c..eoveriiriieiieiietertetereet ettt 6
Changes from PreVIOUS VEISION ......c.eeiiruiertierieeieeie ettt etee et et e e sitesieesbeesbeebeeneeeaeeeae 7
11070101 A USSP 7
Typographical CONVENTIONS ......ccueeiiieriieiiieeiieiiieeieesteeeteesbeesteesbeeesseeebeeeseesseeenseeanns 7

System overview 8
Ericsson WapIDE ........cccoiiiiiieiieiiee ettt et ee s e seeseenseennennnens 8
BIOWSET ...ttt ettt et e s st 8
APPLICALION AESIZNCT .....c.vieuiieieeiieiiesieeie ettt et e et et et eteebesaesseesseesseesseenseennesssenseenseensens 9
PUSH INTEIALOT. ...ttt ettt sttt et ettt be st eanene 9

Installing WapIDE 10
SYSTEM TEQUITEIMENES ..eevvvieeerieiiieeieeiieeeteesteesteesteeseteesteessseesseessaeessseensseessseesseeessseensees 10

SOFtWATE TEQUITEIMENES .....veeevieiiiieeieeiiieeieeeieeeteeereeeteesbeesbeesbeessseesnseesssaesnseessnes 10
Hardware reqUITEMENTS ........eecvieeiieiieeniiesieeeteesreeeteesbeeeaeesbeesseessbeesnseesnseensseens 10
InStallation PrOCEAUIE ........cveiieriieiieie ettt ettt ettt et e e e esaestaenseenseenseenneenes 11
INStAllAtioN OVEIVIEW ...c.eiiiiriiiiiiieiiiiieteteste ettt sttt 11
WAPIDE fI1ES.....eieiiieiieiiiee ettt 11
Uninstalling WapIDE ........cooiiiiiiiiiiiiineceeteee et 11

Using the WapIDE browser 12
StArting the DIOWSET.....cccviiiiieiiieciieeieeete ettt ste e et e e aeeetee e teeenbeesbaessseesnseensseas 12
BIOWSET WINAOW......oouiiitiitieiiiteee ettt sttt ettt ettt eb et e b e et e e emeeeeee 13

ACCeSSING AN APPLICALION. ....vieieiieeiieeiieeiieeeeetee et et eeteeeteesbeeebeesbeeebeesnseesnseens 14
Selecting the dEVICE .....c..eeouiiiiiiiieeeeee et 14
Using the R320S/R5201M DIOWSET .......ccueeriieiieiieieeiiesiieieesieeeesaeseeseeesseeseensesnsesnsesnnesnes 16
Using the device DULLONS .......ccueeriieiieiieieeieeteeee ettt nees 16
ENtering data......cceevuieeiieieeie ettt sttt ettt nnean 16
USIng the OPtioNS MENU ....c.eeiuiereieiieiieieeiieeieeieeteeteeteseeseresseesseesteeneeensesssesseensens 17
USING the R380S DIOWSET.....c..eecuieieiieiiieiieit et eieeitesite it eieetesaeseeesseeseenteensesesessaesseennes 18
INAVIGALINZ. ..eeuvieiieeiieeiiesie ettt ettt et et et et e s e s eesaee st eseenseensesssesseeseenseensesnsesnnenaes 18
ENtering data.......cceeciieiiiiiiieeiieeiee ettt st s reennaee s 18
USING the DULLONS ...eeeuviieiieiiieeiie ettt ere e st e e e e steeesbeeseseesnseennseas 19
Working with DOOKMATKS .......cccviiiiiiiiieiiieciie et s s 19
USING the DIOWSET TIACE ....uvvieiieeiieeieeeieeeiteeiteeieeebeeeteeeteeeeaeeteeessaeessaeesneensaeesseenneas 20
Setting DrOWSET PrefeTENCES. .. .cuiiiiieriieiiieeie ettt et e etee et e et e ebeesabeesseeenns 21
BIOWSET SELLINES .. eeetiieiieeiieeiie et erte ettt st e et eestteesaeesebeeeaeessbeesnseessseesnseesnseessseens 21
GALEWAY SCTHINES ...evvvevienrieereeetesitesieesteeseeteseeesseesseeseessesssesseeseesessesssesseesseenseensenns 22
CACKE SCLLINES ..evievieiieiieeieeiie sttt et te sttt et et e e e e eeeesse et e enseensesssessaesseenseennesnnenns 23
Device-dependent SEHHINGS ........ccverierieriieieeieeieteesieeieseesee st esaeeeeeneeseeesseeeeenneas 24
Testing applications in other Character SES..........ovveverierieriieieeiee e 25
SEANAATA EEXES. c..eveeutenretirterieet ettt sttt ettt 25
WML PIESENLATION ...eovveeiieiieiereeiieit et eeeeiteeeee st e et eteeaesnaesneesseeseenseenseensessaenseensens 25

WaplIDE User's Guide Contents e 3



East ASIan teXT INPUL .....cueeeeuieeriieeieeeieeecieeeteeeteeeteeeteeeteeeseessseessseessseessseessseessseens 25

Using the WapIDE application designer 26
Starting the application dESIZNET ........ccveeierieriieieeie ettt e et esteesbeeeaessaenneas 26
Application designer WINAOW ...........cccvecuieiiieienieniesieeieeee e eee et ere e eeaesnees 26
WOrKing With PIrOJECES .....evviiieiieieeit ettt ettt e e s eaeees 28
Creating @ NEW PIOJECE ..uveeuieriieriieieeitestestesseeseeesteeaeeseesseeseesessessesseesseessesnseensenns 28
Opening an eXiStiNg PIOJECT .....coueeuiruerieriierteete ettt etee st et et eeteseeesbeeseeeseeeee e ae 28
WOrking With flES.....c.eeiuiiiiiiiie e e 29
Creating NEW FI1ES ....eeuiiiiiieiiee et 29
AddIing fileS t0 @ PIrOJECT...ccuviiiiieeiieiiieeiiecteeete ettt et estee et e sbeeeaeesseeensee s 29
Removing files from @ Project .....c.eecveeeiieiiiieeiie ettt sve e 29
Saving and cloSiNg fIlES ......cc.uievuieeiiiiiieeiie e 30
Editing WML dECKS .....ccviiiiiieiieciiee ettt ettt sae e seeneenaeeees 31
Structure 0f WML decks......cc.eiiriiiiiiiininiicieetcceseesceeteee s 31
Inserting elements in @ WML decK ........coocveiirienieiieieeie e 31
FOIMAtting t@XE.....uveiieieiesiieieeeeeieetieste et ete et e st et esteeseeaesneesseeseenseenseensessaenseensens 32
Validating @ WML deck........cccveiiiiiiiieiicieeeeeee et 32
Encoding @ WML decK ........cooiiiiiiiiiicieeeeeee et 33
Editing WIMLSCIIPE fI1ES ....vieuiiiiiiiiie ettt e e e steeenbeesrbeeenvee s 33
TeStING APPIICATIONS. ...cuveeeiieeiieeiieeieeeiteeiee et et e et esbeeeebeesbeessseessseeesseessseessseessseensseens 34
Creating applications in other Character SEtS ..........cccvvvieeciieicieeeiie e eere e 34
Setting application designer PreferenCes .........ovvierieriiierieeie et sve e 36
FOMLS ..ttt ettt st sttt 36
COLOTS. ettt ettt et et 36
C0dE SEYIE ...ttt 37
Working with push messages 38
WapIDE implementation 0f puSh.........c.cocoeriiiiiiieiecieceeee e 39
Using the push INTtATOT ........eoiiiiiiiiiiie et 40
PUSH SEEHINES ...ttt e 42
PUSH OPETAtION. .....iieiiieiiieciie ettt st e et e e st e ebeessbeeenseesnseeenseean 42
Content deTINITION «...eevieiiiiieiieit ettt et st eae 45

PPG COMMUNICATION ...ttt sttt et 49
RECCIVING PUSH MESSAZES ...evveeieiieiieiieie ettt ettt ettt et e entessaessaesseeseenseenns 49
Service INAICATION ...ovieuiiieriieiieieerteeere ettt ettt eneen 49
Other MESSAZE LYPES ..evvemrereriiriirieeitetertente sttt ettt ettt ettt et sae st b sbeeee e eae e 50
Pushing messages to a real terminal.............ccoecveiieiieriiice i 50
Writing applications that generate push mesSages .........cccvevveeierieniienieieeie e 50
Setting up a WAP application environment 51
OVEBIVIEW ...ttt ettt ettt ettt ettt ea e s bt e s bt e et et e e st e sateeaeenbe e bt enteenteseeesbeenbeenees 51
AccessINg 10Cal WML fI1€S .....eeeuviiiiiiciie ettt et ebe e s e eaaee s 51
Using a gateway on the INternet ..........coeeriiiiiiiiiinieieeeeeee e 51
USING @ 10CAl ALEWAY ......eoiuieiieiecieeiieeee ettt ettt ettt e s et e enae e ens 52
Configuring @ Wb SEIVET .......ccviruieriieiieiieieeiesteste st et et eteesteeaessaesseessaesseenseenseenseenns 53
Creating dynamic WML applications...........ccecveruierireiieienieniieieeieeieseae e sseeseeseenneees 53
MANAGING SCSSIONS ...evveereerereierreerteesteeseesstesseesseeseesesssesssesseesseesseesseaseesesssessesssens 53
Creating WMLSCIIpt appliCations........c.ecverieriieriieieeieeiesieieete e seeesseeseesesesesenesseennes 54
Installing a local gateway 55
Downloading and installing the gateway...........ccooeriiriiiiiiineeeeeeee e 55
Configuring the gateway for PUuSh .........cooiiiiiiiiiii e 55
Define push INItIAOT ......ooueeriiiiiiiiiiieeeeeee e 55
Turn off AUtheNtiCAtION .......cceoviiiiiiiiiiiieeiete e 56

4 e Contents WapIDE User's Guide



DEfINE SUDSCIIDET ...ccoiiiiiiiiiiiiee ettt e e e e e e eeeeeeens 57

Define receiver IP address ........oo.eeviiiiiiiiiiiieieeeee e 57
Appendix A: Device limitations 59
DEVICES SUPPOTLEA ...oeveeeeeeiieiieiieie ettt et et eeteseaeseeesse e st eneeesseeseeseenseensesnsesnnennes 59
Optional WAP features not SUPPOILEd........ceevueerieeriiriieeieiie ettt eie e 59
Functions not supported by WapIDE ..........cccocooriiiiiiieieeee e e 60
Glossary of terms 61

WaplIDE User's Guide Contents e 5



Introduction

Purpose and scope of the user’s guide

This document provides information on how to install and use Ericsson’s WAP
Integrated Development Environment (WapIDE) 3.1. WapIDE is a Software
Development Kit (SDK) that helps you develop and test services for a WAP
platform.

Who is this guide for?

This user’s guide is for developers of WAP services. It assumes that the user has a
basic knowledge of WAP. Otherwise we refer to the WAP resources listed in
Related documents and other resources.

Related documents and other resources

Related Internet sites

Ericsson http://www.ericsson.com

Ericsson Developers’ Zone http://www.ericsson.com/developerszone
Ericsson Mobile Internet http://www.mobileinternet.ericsson.com
WAP Forum http://www.wapforum.org

Related documents

These related documents can be found at http://www.ericsson.com/developerszone:
Mobile Phone R320, Design Guidelines for WAP Services

Mobile Phone R380, Design Guidelines for WAP Services

Mobile Phones R520, T20 and A2628, Developers’ Guidelines, WAP Services
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Changes from previous version
The main differences between WapIDE 3.1 and 3.0 are:
e An application designer (WML editor) is added.
e  Support for the R380s smartphone is added.
e Support for the WAP push framework is added.
e Support for connection-oriented mode is added.
e Support for user agent profiles (UAProf) is added.
e The WML encoder now supports other character sets.
e  WapIDE now uses the same cache options as the real terminals.

e Devices can be shown in different colors.

Support

Support can be found at the Ericsson Developers’ Zone (see Related Internet sites)
free of charge.

Typographical conventions

The following typographical conventions are used in this document:

Bold Names of commands in menus, buttons
Italic Specific terminology
Courier Computer text, file names

WapIDE User's Guide Introduction e 7



System overview

Ericsson WapIDE

WaplDE is a Software Development Kit (SDK) that enables operators, application
developers, or any interested party to develop and test real WAP applications swiftly
and easily. WapIDE can be downloaded free of charge from the Ericsson Develop-
ers’ Zone.

The main functions in WapIDE are:

e The browser simulates a WAP device and allows you to test WAP applications
on different Ericsson phones.

o The application designer lets you create and test your own WAP applications.

e The push initiator sends push messages to the WapIDE browser or a real
terminal.

An online version of this User’s Guide can be accessed directly from the Windows
Start menu or from inside WapIDE by using the help menu.

Browser

The WapIDE browser allows the user to access WML decks and cards using a
simulated WAP device. The following Ericsson devices are currently supported:

e R320s
e R380s
e R520m

The Chinese versions of these terminals are also indirectly supported since Chinese
characters can be entered from the computer keyboard.

The browser can access content from a web server via a WAP gateway or from a
local disk.

=
=
@ = =1 content
= N0 J000000
/UUDUUUU\' /DUUUUDU\'

8 e System overview WapIDE User's Guide



Application designer

The WapIDE application designer is a WML editor with which you can design and
test WAP applications. There is also a WMLScript editor for writing and compiling
WMLScript code.

WML, WMLScript, and other files can be managed in projects.

The application designer is integrated with the WapIDE browser so you can easily
test your applications on different devices.

[EdwaplDE - untitled [_[O]x] [EIR520m - WaplDE  [i[=] E3
File Edit Wiew Tools Help File View Bookmarks Help
OE@E@S -« i aapd i [oedgm@drs=A 0| s s A5 E ¢
5 untitied ascesskey_1 wm | et 01 ] dislogs wmis|
[ test_01.wmi
-1 accesskey_01.wml <ol ~rLone
IP) cardjarcesskey 1] <!DOCTYPE "'~/ /UAPFORUM/ /DTD WML 1.2/ /EN"
5] cardLink followed] “hitp: 4w wapforum, org/DTDAmLLZ , dud"s
== <!-- WapIDE SDK WML Applicatien Wed Now 17 20:42:43 U. Eurcpe Daylight Time 1999 ——>
s 0 | <l
BR br <card ~rhccesskey 17
o test <prLext
& anchor <a =L =TElinkl™>link 1</ ax
® text more text<br/><br/f>
® dialogs.wmls <a ~"agcesskey_02.uml"rnext< /s
<a =raccesskey menu. wml Hupd/as
</p=
</oards >
Aftribute value <card ="1linkl™ ="Link followed™s
align e <
e It worked!<br/>
ymllang <anchors
id <prEv/>
s </anchor>
</p>
<jeards
<fimls
Row: 7 Gol: &

[ER380s - WaplDE =] B3
File View Bookmarks Help

74 Mobile Internet

ERICSSON 2
Login
SignUp

Arnouncement
Cunencies

= nossoma

Push initiator

The WapIDE push initiator is used to create and send push messages to the WapIDE
browser or a real terminal.

WapIDE Push Initiator = [~ WAP Client
Push Proxy Gateway
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Installing WaplIDE

This chapter describes the system requirements and installation procedure for
WapIDE.

WaplIDE can be found at the Ericsson Developers’ Zone (WAP -> Developers’
tools). To access the zone you have to register at the web site. The registration
gives you access to the documentation and developer resources located at the site.

System requirements

Software requirements
e  Microsoft Windows NT 4.0, Windows 98, or Windows 2000.

e Java 2 Platform, version 1.3.0 or later. Java can be downloaded from
http://java.sun.com.

e Microsoft Internet Explorer 5, or a later version, is required for local WML file
access, including the use of the application designer.

e The font Arial Narrow is required to get a correct simulation of the real

telephones. Arial Narrow is part of many Microsoft software packages such as
Office 97, Outlook 2000, Word 2000, etc.

e Adobe Acrobat Reader 3.0 or later is required to view online documentation.
Acrobat Reader can be downloaded from http://www.adobe.com.

In some cases it is also necessary to install a WAP gateway as described in Setting
up a WAP application environment on page 51 and Installing a local gateway on
page 55.

To use WapIDE with other character sets, such as Chinese, the following is
recommended (see Testing applications in other character sets on page 25 for more
information):

e  Windows 2000.

e Java 2 Runtime Environment (JRE) 1.3.0, internationalized version.

Hardware requirements
e 20 Mbytes free disk space is required for installation.

e Pentium II, 266 MHz and 128 Mbytes RAM is recommended to get acceptable
performance.
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Installation procedure
To install WapIDE on Windows:
1. Install the prerequisite software listed above.

2. Download the file WapIDE 31.exe from
http://www.ericsson.com/developerszone.

3. Run the file WapIDE_31.exe (by double clicking on it) and follow the
instructions.

Installation overview

By default, an Ericsson WapIDE 3.1 menu is added to the Programs section of the
Windows Start menu. The structure is:

Ericsson WapIDE 3.1 » Application Designer ~ (The WML editor)

Browser (The WAP browser)

Push Initiator (The push message creator)
Readme (Release notes)

User’s Guide (This manual in PDF format)

WaplIDE files

The default directory for installation is
C:\Program Files\Ericsson\WapIDE 3.1

The following subdirectories are created:

"7 WapIDE 3.1 Root directory.
— [ bin Java archive (JAR) files and DLLs.
— ] dat WaplDE settings, bookmarks, and DTD files.
— ] device Device-specific code and settings.
— 1 doc This User’s Guide in PDF format.
— ] samples Contains samples, a default home page, and is the default

root directory for file:// accesses.

Uninstalling WapIDE

To uninstall the WapIDE use the Windows Add/Remove Program in the Control
Panel folder in the Settings section of the Windows Start menu.

Note: Deleting the WapIDE files and directories manually will not completely
uninstall it. You have to use the procedure above.

WapIDE User's Guide Installing WapIDE e 11



Using the WapIDE browser

The WapIDE browser is used to view WAP applications. It can be used instead of a
WAP device to access WML decks developed by you or others. It also interprets
WMLScript.

The browser can simulate different devices. It also supports applications in
languages with different character sets, such as Chinese.

There are two ways to load content to the browser; from a:
e Local WML file
e  Web server via a WAP gateway.

To access web servers on the Internet, you can use a WAP gateway on the Internet.
If you want to test applications on local web servers, or if you are placed behind a
firewall that prevents you from communicating with external gateways, you can
download a gateway from the Ericsson Developers’ Zone. Refer to Setting up a
WAP application environment on page 51 for more information.

Starting the browser

Start the browser by selecting
Programs » Ericsson WapIDE 3.1 » Browser

from the Windows Start menu.

The window shown on the next page is opened. Initially, the browser starts with the
R520 device and the default home page (a local WML file).

The default gateway is one that is available for external test use at the Ericsson
Developers’ Zone. To change the gateway, refer to Gateway settings on page 22.

12 e Using the WapIDE browser WaplIDE User's Guide



Browser window

R520m - WapIDE [Hi[=] E3

File “iew Bookmarks Help | Menu bar

ﬁ % . .'—Toolbar

[file#1C:iProgram%20Files/Eri ™ [T~ Location bar

Device

ERICS5ON =
¥ifaplDE 3.1 i
ERICSSON ?- : Device display

VwaplDE 3.1
Gateways

Device buttons

At the top of the browser window is a menu bar, a toolbar and a location bar. Below
that is the device.

The toolbar offers quick access to common menu choices. It also contains a
“progress indicator” that rotates while a file is being loaded. The location bar allows
you to enter a URL to load, and also keeps an history list of previously entered
URLSs. The toolbar and location bar can be removed (using the View menu).

Initially, the window is shown with a default size, but it can be resized (e.g. to make
the location field wider). The device picture can be moved (by dragging it),
centered, or locked within the window (using the View menu or a pop-up menu).
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Accessing an application

Applications are accessed by an URL. To load a URL, you can do one of the
following:

e Type the address in the Location field as a normal Internet URL, e.g.:
http://mobileinternet.ericsson.com

You can also load a local WML-file by typing
file://C:/path/file.wml

If you use a relative file URL that does not start with e.g. C:, the reference is

relative to the WapIDE samples directory. For example,
file://projectl/test.wml

1s the same as
file://C:/Program Files/Ericsson/WapIDE 3.1/samples/
projectl/test.wml

e Select an URL from the history list for the Location field.
e Select a bookmark as described in Working with bookmarks on page 19.

e Seclect Load URL from the File menu and type a URL in the same way as
above.

Load URL =]

Load LIRL:
|http:ﬂmnt3iIeinternet.ericssnn.cnm

2k | Cancel | Browse

Pressing the Browse button opens a file chooser window where you can select
local WML files to load (file://... access).

The browser will load the application and show the first card in the display.

Note: At Ericsson Mobile Internet there is a list of links to WAP-enabled sites that
you can try.

Selecting the device

To open the current card with another device, select Load device from the File
menu.

Elr520m - wapiDE  [Mi[=] E3

=N “iewe Bookmarks Help
Load URL...

Ezxit

- & R520m
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The window switches to the selected device.

R320s R520m
Elr320s - wapiDE =] 3 ElR520m - wapiDE  [HI[=IEY
File Wiew Bookmarks Help File “iew Bookmarks Help

R380s

R380s - WaplDE [ O] ]

File View Bookmarks Help

F:ﬂ Mobile Internet
ERICSSON 2

Login

Signlp
Announcement
Currencies
hdnhila Chat

= NOssdIu3

The browser capabilities of the different devices are described in the following
sections.

For further information on the user interface of Ericsson WAP devices you can
download Design guidelines for different Ericsson WAP terminals from the Ericsson
Developers’ Zone.
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Using the R320s/R520m browser

The R320s and R520m devices are very similar.

Using the device buttons

When the browser is started you can see the application in the display and use the
buttons on the device to enter commands and data.

Button User action

Device action

Short click

Hold-down

Follows the current link, confirms input or
selection, etc

Shows a list of options, as described in Using
the options menu below

Goes back in history

Up / Down

- Short click
NO

Left / Right

Scrolls up or down in the current card or
selection list

Scroll left or right in tables (or between
multiple links on the same row)

click
0]

i 0 Short click

Text entry in input fields. The * and # buttons
are also used for selecting check boxes.

For cards with “access keys”, these buttons can
also be used as a quick way to activate a link or
input field (R520m only). Access keys are
indicated with a small icon next to the link or
input field.

Entering data

You can enter data in input fields in two ways:

e By clicking on the buttons on the device. This works in the same as for the real
telephones (e.g. press button 2 three times to get the character C).

e By using the computer keyboard. This is a faster way to enter text. The Enter
key corresponds to the Yes button and the Esc key to the No button.

a]u]]

|

Input fields can be in different formats, such as numeric, alphabetic, etc and of
different lengths. WapIDE verifies that the input is in the correct format, and stops
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you from entering e.g. alphabetic characters in numeric fields or strings that are too
long.

When you enter text on a real telephone, a character menu is shown in the upper
right corner each time you press a button. WapIDE shows similar information in a
small pop-up window (“tool tip”’) when you hold the mouse over a device button.

Using the options menu

When you hold down the Yes button, an options menu is shown. (On the R320s
device, a short click on Yes will also display the options menu if no link is in focus.
On the R520m device, the microphone button will also display the options menu.)
The options menu contains any actions defined in the current card (“soft options”).
In the example below, prev and Tv4 . SE are such options.

" Options menu

The options menu also contains a number of fixed options (such as 1 Mobile
Internet above) but these options have no effect in WapIDE. The same functions
(reloading the page, adding a bookmark, etc) can be performed from the menu bar.
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Using the R380s browser

The R380s device is quite different from the traditional mobile phones. It provides a
large touch-screen and is controlled with a pen instead of buttons on the device.

R380s - WaplDE [_ (O]

File View Bookmarks Help

&2 @[

|htlp:ﬂmubileinternet.ericssun.cumfd.asp?_s=9?6493522 j

_ Mobile Internet
ERICSSON 2

Login
Signllp
Announcement

Currencies
hdnhila ™ hat

£ NOsS3IH3

Navigating

Follow links by clicking on them with the mouse (like in a web browser). Click on
the arrows in the scroll bars to scroll horizontally or vertically.

The browser keeps a history list of visited applications. The Back button goes back
to the previous card. When the first card in the current application is reached, Back
goes to the first card in the previous application.

Entering data
Open input fields and single-select fields by clicking between the <> brackets.

User ID: T
bob B
*lglwlel[r[t{y[ufifofp|-[= =
Capsla[sfd[flalh[ik[V]:[:]" |wdf Q3
& Jz[xfefvbnm[,[. /]2 ]&] ~~yfe
"l [C]) [&]! @ &b

A1

WaplDE allows text input from the computer keyboard only. The real R380s device
allows text input from an on-screen keyboard or a character recognition screen but
these methods are not supported by WapIDE. The on-screen keyboard is displayed
but has no effect.

Click on @ to confirm the input and return to the main window.
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Using the buttons

At the right-hand side of the screen is a menu with buttons:

@ ()

The desktop button does nothing (WapIDE only emulates the WAP
browser part of the R380s).

The tasks button opens a menu with different options but selecting them
has no effect. Some of the functions on this menu (reloading the page,

adding a bookmark, etc) can be performed from the WapIDE menu bar.

PDEE

The view button works in the same way as the tasks button.
The back button goes back to the previous page as described above.

The stop button is only shown while a page is being loaded. It works in the

same way as the stop button on the WapIDE toolbar.

Working with bookmarks

Bookmarks work in the same way as in a web browser. Add a bookmark for the
current card by selecting Add from the Bookmarks menu. It is recommended that
you bookmark only the first card in an application. Other cards may have

dependencies on the browser context.

To retrieve a bookmarked card you select it from the Bookmarks menu.

R520m - WaplDE =]

File “iew Help

ﬁ @9 a Add
Edit...

fe=1178cc= (] News R
2 Maohile Internet
= vl ze

When you add a bookmark, a file with the bookmark name is created. As shown in
the example above, you can create a tree structure of bookmarks by moving them to
subfolders. This must be done outside WapIDE using e.g. Windows Explorer.

Bookmarks-Edit... opens a window where you can delete and rename bookmarks.

WapIDE User's Guide
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Using the browser trace

In the browser trace you can see system events of different types. Selecting Trace
from the View menu opens the trace window. The trace window is also opened
automatically if an error (such as a timeout) occurs.

Tla-::e - wWaplDE M= 3

File Options

Al | Cnnsnle| Device' WﬂE' Netwu:nrk' F'uah'

CON: Zearching for installed devices: -
COM: Found device: com.ericsson.wap.browser.qui.device.R320s.D¢
COMN: Found device: com.ericsson.wap.browzer.qui.device.R3502.D¢
COM: Found dewvice: com.ericsson.wap.browzer.gui.device BS20m. De

CON: Loading device: R380s

CON: FileManager loading dewice settings for R380s

CON: [C-Log] Processing local file: Ci/Program Filezs/Ericsson/Wap:

CON: [C-Log] Processing local file: C:/Program Files/Ericsson/Wap:

CON: Tracing for "Dewice™ is turned on

CON: Tracing for "WAE™ iz turned on

COM: Tracing for "Network™ iz turned on

CON: Tracing for "Push™ is turned on

WaE: JNTI MMIcLoadURL(l, mobileinternet.ericsson.com, false)

WAE: JHNI MMIaStatus(l, 1, http://mobileinternet.ericsson.com/)

NET: Content iz opened [(http://mobileinternet,ericsson.comns) _Ij
4

Kl

The trace messages are divided into different tabs:

All All trace messages in the order they were written.

Console Startup messages, settings, etc. The console trace is always on since
it can contain startup errors and other important information.

Device Device-related traces.

WAE Wireless Application Environment (WAE) information, related to
the WAP stack and interpretation of WML code.

Network Network communication traces such as files read from the network.

Push Push-related traces.

By default, only the Console trace is active. The other traces (Device, WAE,
Network, and Push) can be activated using the Options menu.

Using File-Clear, you can clear the traces written so far for the current tab. File-
Clear all clears all traces.

Some of the messages in the trace window contain internal WapIDE information
that is normally not relevant to the user but can be important if you report a WapIDE
problem.
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Setting browser preferences

Selecting Settings from the View menu opens the settings window. There are four

tabs in the window:

Browser
Gateway
Cache

Device-dependent

Browser settings

This tab contains general browser settings.

B wapIDE - Settings

| Gatewayl Cachel REEDml

~Home page

Clicking the Home button will take you ta this page

Location: hle:fhwelcnme.wmlc

—Histary

Size of history list: |1 1]

~Location bar history

Zlear the list of sites on the location bar: Clear |

Reset |

(0]14 | Cancel |

Home page

History

Location bar
history

WapIDE User's Guide

The home page is loaded when WapIDE is started and when
the Home button is pressed.

WaplIDE keeps an internal history list of loaded WML decks.
The size of this list limits the number of times you can go back
to the previous card.

The location bar history list contains all the URLs entered in
the location field. Pressing Clear empties this list.
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Gateway settings

‘w’apIDE - Settings
Browser | Oateway| cache | Raz0m |
~Gateway
Select the WAP gateway to use:
ITest G *I
Add... | Edit... | Celete |
~Connection
Tirmeout; ISEI seconds
Mode:; ¥ connectionless © connection-oriented
Sectrty: [
Feset | 0] Cancel

Gateway

Add...

Edit...

Delete |

Timeout
Mode

Security
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Select the WAP gateway to use from the list. The default
gateway is one that Ericsson provides for external test use (IP
address 195.58.110.201). See the Ericsson Developers’ Zone
for more information.

When you add or edit a gateway, the following information
can be entered:

= Title - An optional description of the gateway. If not
specified, the IP address is used.

= [P address - The IP address of the gateway (required).

= User ID/Password - Some gateways require a user ID and
password.

Removes the selected gateway. Note that no confirmation
window is shown.

The number of seconds that WapIDE will wait for a reply
from the gateway.

Use connectionless or connection-oriented sessions (not
supported by the R320s device).

Not used.
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Cache settings

To improve performance, WapIDE keeps a non-persistent cache memory where the
downloaded files (WML, WMLScript and images) are stored.

B wapIDE - Settings
Elrnwserl Gateway Cache | REEDS'

Cache description

The current device is using a cache of 32 kB. The cache is
configured to always check for a newer wersion of an
expired docurment. If no "expires date" is given with a
cached iterm, itwill remain in the cache for 72 hours.

[T Disahle cache Clear Cache

Reset |

(0]14 Cancel

Cache description WapIDE uses the same cache size and options as the devices it

Disable cache

Clear Cache

WapIDE User's Guide

simulates. This field describes the cache settings for the
current device.

Turns the cache off. While developing dynamic applications,
it is recommended that you disable the cache to ensure that the
decks are reloaded each time.

Empties the cache memory.
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Device-dependent settings

The options available in this tab depend on which device is currently active. The
example below is for R380s.

Cache size:

Dievice imade:

B wapIDE - Settings

WAR broweser lanouage: IEninsh *I

Show title sequence: [

|Classic Blue LI

Reset |

(0]14 Cancel

Cache size

WAP browser
language

Title bar sequence

Device image

WAP browser font
size
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For the 380 device, you can select the size of the internal
cache memory (0, 4, 8, 16 or 32 kB).

The language can be set to English or (simplified) Chinese.
Note that this only controls the language for the fixed texts in
the device. The WapIDE windows are always in English.

See also Testing applications in other character sets on page
25.

For the 380 device, this indicates that the titles of the
preceding cards in the application should be included in the
window title (e.g. Card 1 > Card 2 > ...).

For each device, you can choose between different colors.

For the R520 device, you can specify the font size to use in the
device display (small, medium, or large). This affects the
number of lines that can be shown.

When the language is set to Chinese, the largest font size is
always used.
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Testing applications in other character sets

It is possible to test WML applications in other character sets, such as Chinese.
Windows 2000 is recommended for developing international applications. Below,
some aspects of using other character sets are described.

Standard texts

The standard texts in the device can be
displayed in English or Chinese (see Device-
dependent settings on page 24). To use the cama

Chinese language you must have a Unicode ﬁ‘ @5 . .
font on your computer.

Windows 2000 has full support for East
Asian languages built in. For other
Windows versions, you must install a

Unicode font and update the Java
font .properties file.

-ioix]

File “iew Bookmarks Help

WML presentation

WAP applications in any language can be
presented in the browser. A Unicode font is
required as described above.

East Asian text input

The Chinese models of the Ericsson phones
allow entry of Chinese text from the device
buttons. WapIDE does not support this.

BER" i
 BFEMEES
:.: ﬁ_ |

Instead, you can use an Input Method Editor
in Windows 2000 that allows you to enter
Chinese text from the computer keyboard.

The default system locale must be set to the
language you want to use. The Input
Method Editor is started automatically when
you enter text in input fields.
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Using the WapIDE application designer

The WapIDE application designer is a WML editor with which you can design and
test WAP applications. There is also a WMLScript editor for writing and compiling
WMLScript code.

WML, WMLScript, and other files can be managed in projects.

The application designer is integrated with the WapIDE browser so you can easily
test your applications on different devices.

Starting the application designer

Start the application designer by selecting
Programs » Ericsson WapIDE 3.1 » Application Designer
from the Windows Start menu.

The application designer opens with the last project used. The first time it is started
there is an empty project (‘“untitled”).

Application designer window

At the top of the application designer window is a menu bar and a toolbar. Below
these are a number of different areas, or panes:

o The project pane shows a tree view of the current project, the files in the project,
and the structure of the WML files.

o The attribute pane shows the attributes of the current project, file, or element in
a WML file.

e The source pane shows the source code for the selected WML or WMLScript
file. Each open file is shown in a separate tab.

e The message pane shows messages from compilation etc.

All panes can be resized and scrolled if necessary.
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Menu bar

EdwapIDE - untilled

Toolbar

Source pane

File Edit View Tools Help
O-S@H@S o 0 BB EF T 0 el m@tne =BT |pzrTAsE+
= urritled accasskay_01 wmi | te_01wimi| diatpas iz
[ test_01 vl
accasskey_01 wiml <rrml ="L.0mex
< IDOCTYRE " ATAPFORIM /DTD WML 1.2/ /EH"

-7 cardaccesskey 1]
=0 card[Link followsdd]
=1A

"hrep: Jnqu. wapforun. ok g DTD Amll2 . ded™>
£!-- WapIDE 5DE WML Applicartior| Wed How 17 Z0:42:43 W. Europe Daylight Time 1993 ——>

<uml
<card =""Aocesskey 17
LpFText
<a ="l ="Elinkl"=1ink 1</a%
: _ * texd more textohr schr
“o# dizlogzwmls <& -rapcesskey 0Z.WhlTeneNto o
<a ="accesskey mena.wml™Fups Sax
< p>
< foards
Attrlbute value <card ="1link1" ="Lirnk followmed™>
align left R
T It worked!<hrs>
kmil-lang <anchors>
i . CpreviE
class <sanchor>
</p>
£ foards
</l
Row: T Col &
Project pane Attribute pane Message pane
The following functions are available from the menu bar. Many of them are also
available from the toolbar.
File Edit Tools
| ey r 3 Undo Citl+Z [M Walidate "“welcomewml' F12
= Open project... Alt+Shift+F T4 Redo Cirl+Shift+Z & validate all
#Agd to project ] # cut Cirl+x [ Test “welcome.wml F9
Close "welcomewrml” Copy Ctrl+C 22 compile "welcome wml® Ctrl+Fg
Close all Ctrl+Shift+F4 EIEESTE Crl+y
Rermove fram project “welcame.wml" * Delete Delete
Save project Insert 3 Help
Save project as... #A Find.. Ctrl+F B User's guide
'
= save "welcomewm!" Cirl+35 “t Replace... Ciri+R P About'WaplDE
Save as...
&l save al Crl+Shift+A
& Brint "welcome wml* View
Print preview "welcame wml* v MES_SGQES Ll
Frinter settings SEITEE
Exit
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Working with projects

To simplify the administration of WAP applications, the source files are grouped
into projects. Information about a project is saved in a project file (with the
extension .wpr).

There is always one project active. If you don’t want to work with files without
storing them in a project, use the default project (“untitled”’) but never save it.

Creating a new project

To create a new project, select File — New » New project from the menu bar. The
following window is shown:

Mew Project

Froject name: | Type: |-.r-1pr

Froject directony: hapide_nglbimcnmlericssnmwapleditur |

Wil Wersion: 11 12

~Descriptian:
Cancel |
Project name The name of the project file.

Project directory  The directory for the project file.
WML version The default WML version for files created in the project.
Description An optional description of the project.

The project properties are then shown in the attribute pane when the project is
selected in the project pane.

Attribute Value |
comments Default Project
currentDid 1.2
projectLocation  |IAprojectweapid...
projecthlame untitled

Opening an existing project
To open an existing project, select File - Open project... from the menu bar or

press the L= jcon and locate the project file.
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Working with files

Multiple files may be open at the same time. Each file is shown in a separate tab in
the source pane. Files are opened when you click on the file in the project pane.

When you hold the mouse over a file name in the project pane, the full path to the
file is shown in pop-up window (“tool tip”).

In the source pane, normal text editing functions, such as cut & paste, undo/redo,
and find & replace are available.

Creating new files

Select File — New » New WML deck or New WMLScript or press the - icon to
create a new file. The window below is shown.

New Deck

Deck name: | Type: |wm|

Deck directony: f.fapide_nglbinlcumlericssnnlwapleditur |

: Cancel |

A new file is automatically added to the current project.

When a new WML file is created, it contains the required header tags (?xml,
'DOCTYPE, and wml) and a card with an empty paragraph.

Adding files to a project

To add a file to a project, select File — Add to project » Add WML deck or
Add WMLScript or press the - icon and locate the file.

When a WML file is added it is validated against the DTD (stored locally). If there
are invalid tags, error messages are written but the parsing continues and the file is
shown.

Other file types, including WMLScript (.wmls), pictures (.wbmp, .gif, and .jpeg) and
different text files (.txt, .html, .jsp, and .asp) are shown as a single node in the
project pane. The source code is shown if possible.

Removing files from a project

Select File — Remove from project to delete a file from the list in the project pane.
The file itself is not changed.

Note that this works on the file selected in the project pane — not on the currently
active tab like other menu options.
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Saving and closing files

Modified files are marked with small red x in the file icon. You can save a selected
file or all modified files.

When you close files, or exit the application, WapIDE prompts you for the modified
files.

Elselect
[ text 01wl
¥ table_14wml
[¥ dialogs.wmls

Mone | Ol{l Cancel
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Editing WML decks

Structure of WML decks

A WML deck contains one or more cards and, optionally, a

template. The template contains elements that are common to
all cards. A typical example is a “Back’ action that should be

B untitied

=-[A penguinwmi
#-7) card[Pizza Penguin]
=1 cardinop]

w7 card[Select Pizzal
w7 cardMame & Address]
®-7) card[Contact Us]
w7 card[Oven On]

-0 cardfwhat's On

Attribute Walle

align |ett

mode

wml:landg

id

class

Card 2
Card 1

present in all cards.

The order of the cards does
not matter except that the
first card in the deck is the
one that is displayed when
the deck is loaded.

The structure of the WML deck is shown in a
tree in the project pane. When you click on an
element in the tree the source for that file is
displayed and the attributes of the elements are
shown in the attribute pane.

In this example the p (paragraph) element has
been selected and the attributes for the
paragraph are shown. The only attribute
specified (or defaulted) is align. The other
attributes are shown in a different color to
indicate that they have not been specified.

Inserting elements in a WML deck

From the toolbar (or by using Edit — Insert » ... from the menu bar) you can insert
new elements into a WML deck. The elements that are allowed at the current
position are highlighted, the others are gray.

These toolbar icons are used to insert elements:

- template, head, meta, access g

card
k] do

1 p

FRE pre

a a

3 anchor
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br

)

fieldset
= select, option, optgroup
image

input

@DEEIMM

table, tr, td

9 timer, onevent, go, prev, noop,
refresh, setvar, postfield
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When you insert an element, a pop-up menu with the element attributes is shown.

E;g card attributes
title I
hiewe ortext = frue % false
ordered * frue " false
onemterfarward |
onenterbackward |
ontimer |
Cancel |

Three attributes (xml:lang, id, and class) are available on all elements but not often
used. They are not shown in the attribute list.

Formatting text

The bold, italic, underline, big, small, emphasis, and strong icons on the toolbar are
used to format selected text parts.

B 7 UALE T

Select the text to be formatted and press the icon (or select Edit — Insert » Markup
» ... from the menu bar).

Validating a WML deck

When you open a WML file the WML structure in the project pane and the element
attributes are created. As you modify the WML source code there is no automatic
update of the project and attribute panes.

To verify the syntax of a WML file, and update the project and attribute panes,

select Tools — Validate or press the [ icon. If there are syntax errors, messages
are shown in the message pane.

welcomeswrnl, * FatalError **, The end-tag for element type "p" must end with a =" delimiter. Line: 14 Column; 1

You can click on a message to highlight the line with the syntax error.

You can also validate all WML files in the project by selecting Tools — Validate all.
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Encoding a WML deck

WML files can be encoded (i.e. compiled) to verify the syntax and to create a
compiled (.wmlc) file.

Select Tools — Compile or press the Bt icon to compile a file. If it is modified, the
file is automatically saved before compilation.

Compilation information and error messages are shown in the message pane. The
compiled file is stored in the same directory as the source file.

Editing WMLScript files

The WMLScript editor is a standard text editor.
WMLScripts can be compiled to verify that the syntax is correct and to create a

compiled (.wmlsc) file. Select Tools — Compile or press the Bt icon to compile a
file. Compilation messages are shown in the message pane.

[Compiler] REead l66 bytes into buffer
[Compiler] Compiling WML3cript file: E://calc.umls
[Compiler] The result iz stored in E://calc.wmlsc
[Compiler] The f£ile si=e iz 51 bytes

The compiled file is stored in the same directory as the source file.

As with WML files, it is not necessary to compile WMLScripts to test them in the
WAP browser but it is the only way to test the syntax since there is no validate
function for WMLScript.
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Testing applications

For WML decks, select Tools — Test or press the P icon to display the current deck
in the WAP browser window. If the file has been modified, it is saved before the
browser is invoked.

WapIDE

Application WAP browser
designer

Test Y
N

.wml
.wmls

Compile ~_

AT
)

.wmlc
.wmlsc

N~

Note: It is not necessary to compile the files to test them in the WAP browser.
When you test an application the browser automatically compiles WML and
WMLScript to temporary files.

Creating applications in other character sets

To create applications in other character sets than ASCII, you should specify the xml
encoding parameter (on the first line in each WML deck), for example:

<?xml version="1.0" encoding="iso-8859-1"7?>

The WML editor checks the encoding parameter when it reads and writes WML
files.

Note: If no encoding is specified, the system default encoding is used. This means
that the encoding can change if you move your files to another machine.

The character sets supported in the WML editor depends on the support in Java and
the operating system. When you compile or test your applications in the WAP
browser, the following character sets are supported:
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Type

Character set

Aliases

Unicode

Western
European

Central
European

Baltic
Arabic

Greek

Turkish

Japanese

Korean

Chinese

Thai

1s0-10646-ucs-2
150-10646-ucs-4
utf-8

utf-16

us-ascii

150-8859-1

150-8859-2

windows-1250
windows-1257

1S0-8859-6

180-8859-7

windows-1253
150-8859-9
shift jis

euc-jp

150-2022-jp

ks_c_5601-1987

euc-kr
gb2312
big5

windows-874

cp819, csisolatinl, ibm819, iso 8859-1, is08859-1,
1s0-ir-100, 11, latin1

csisolatin2, iso 8859-2, is08859-2, iso-ir-101, 12,
latin2

arabic, csisolatinarabic, ecma-114, iso_8859-6,
1so-ir-127

csisolatingreek, ecma-118, elot 928, greek, greeks,
iso_8859-7, iso-ir-126

csisolatin9, iso_8859-9, latin9
ms_kanji, csshiftjis

extended unix code packed format for japanese,
cseucpkdfmtjapanese

csis02022jp

cp874

All character set names are case insensitive.

WaplIDE User's Guide
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Setting application designer preferences

These settings control the text presentation in the application designer source pane.

Fonts

Settings
Fants | Culnrs| Code Style'

Fonts Sizes

Monospaced L"1 2 LI

Pick a font, size, and style to change ne

Cancel |

Font Select the font to use from the list.

Size Select the font size from the list.
Colors

Settings

Fonts  Colors | code sty |

Attribite

INl:nrmal Text r |

< --Comment—->»

=tag uoted Value™ Tnoted_wvalue:
Hormal text

sipecial Caracter:

<! Javalicript'=

Cancel |

Attribute Select the attribute type to change the color for from the list.
| Press this button to open a color chooser for the selected attribute.
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Code style

E'_'j Settings

Use smart When this box is checked, new lines are indented at the same
indenting position as the previous line.
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Working with push messages

Push is a new WAP feature. In the traditional “pull” case the transactions are
always initiated from the client. Push technology allows a push initiator,
somewhere on the Internet, to send content to a WAP client via a push proxy
gateway (PPQG).

[— Push Access || Push Over-the-Air
= Protocol = Protocol e
- -
| — s
I IR Ed
0000000~ 0000000~ N
Push Initiator Push Proxy Gateway WAP Client

The push initiator sends content to the PPG using the push access protocol (PAP).
The PPG delivers the push message to the WAP client using the push over-the-air
protocol (OTA).

PAP uses XML documents that are sent over HTTP. The following operations are
defined:

Push submission (initiator to PPG)

Result notification (PPG to initiator, not supported by WapIDE)
Push cancellation (initiator to PPG)

Status query (initiator to PPG)

Client capabilities query (initiator to PPG).

PAP allows any content type to be pushed to the WAP client. However, the client
may not be able to receive them. The WAP standard defines three push content

types:

e Service Indication (SI) — send a notification to the WAP client.

e Service Loading (SL) — cause the WAP client to load and execute a service.
e (Cache Operations (CO) — invalidate content objects in the WAP client cache.

Different security levels can be used for authenticating the push initiator, such as
TLS/SSL, signed or encrypted content, HTTP authentication, or no authentication
(in a trusted network).

For a complete description of the WAP push framework, refer to the specifications
on www.wapforum.org.
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WapIDE implementation of push

WapIDE supports push in the following way:

o  WaplDE provides a push initiator where push messages can be created and sent
to a push proxy gateway using PAP.

e Normally, the PPG sends the messages to a mobile phone. The Ericsson
Enterprise WAP Gateway/Proxy 2.0 (or WAP Gateway/Proxy 3.0) can be
configured to instead send the messages to the WapIDE browser (using an
internal protocol). Refer to Installing a local gateway on page 55 for
configuration instructions.

e The WapIDE browser can receive and display push messages in the same way
as the real devices. Push is currently supported by the R520m device only.

WapIDE
Push initiator WAP browser
Push
Enterprise WAP
Gateway/Proxy

You can also use the WapIDE push initiator to push messages to a real terminal, or
use other push initiators with the WapIDE browser.

Note: When the gateway is configured to send push messages to WapIDE, all
messages will be sent to one WapIDE browser regardless of the address specified in
the push message. To push messages to another WapIDE browser, or to a real
terminal, the configuration must be changed.

The WapIDE push initiator supports two security levels:
e No security

e HTTP basic authentication.
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Using the push initiator
Start the push initator by selecting
Programs » Ericsson WapIDE 3.1 » Push Initiator

from the Windows Start menu.

B Push Initiator - WapIDE

aplDE_3.0_PIi1

I

11111111

WithP Service Indication

<ruml wersion="1.0"2>
<!DOCTYPE pap PUBLIC "-//WAPFORUM//DTD PAP 1.0//EN"™ "http: /v, wapforum
<paps
<push-neszage push-id="WapIDE 3.0_PFI/0"-

<addreass address-value="wappush=+11111111/type=plunideip.ericaaon. 3e™ /=
<ipush-message-
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The WapIDE push initiator allows you to create push messages and send them to a
push proxy gateway. It also receives and displays responses from the gateway.

The push initiator window has three main areas:

Push Operation — defines the type of push operation and control information
that the PPG uses to send the message to the correct client.

Content Definition — the push message content intended for the WAP client
(only present for push submission operations). The push message can consist of
one or more parts.

PPG Communication — shows the messages sent to and responses received
from the PPG in XML format.

The following steps are used to send a push message to the WapIDE browser (or
another client):

L.

Open the push settings window and enter the correct PPG information. See
Push settings on page 42 for more information.

Select the Push Submission tab and enter the PAP header information for the
PPG. See Push operation on page 42.

Define the content to be sent to the WAP client. It may consist of one or more
parts. See Content definition on page 45.

Send the message by pressing the Send Message button or by using File — Send
from the menu bar. You can also look at the PAP message source before it is
sent by using File — Preview.

Check the response messages from the gateway. See PPG communication on
page 49.

Check the result in the browser. See Receiving push messages on page 49.
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Push settings

Select View — Settings from the menu bar to open the Push Settings window. These
settings must match the configuration of the gateway (see Configuring the gateway
for push on page 55).

‘w’apIDE - Push Settings

Push Prowxy Gatewsay LIRL: |http:ﬁ1 27.0.0. Vppoctrifppocontrollogic.dll

Lige Basic Authentication [

Llzer D Mapide
Fasswiord: Iu“dapid931
FPG Address Domain: |eip.eri|:55|:|n.ae

Default Target Address: |+11111111

0] | Cancel |

Push proxy gateway URL  The URL for posting push messages. For Enterprise
WAP Gateway/Proxy, it should be specified as
http://<hostname>/ppgctrl/ppgcontrollogic.dil

Use basic authentication  Indicates that HTTP basic authentication should be
used when posting to the PPG. Otherwise, no security

is used.
User ID If basic authentication is used, the user ID and
Password password must be specified.
PPG address domain The Internet host name of the PPG. Ignored by

Enterprise WAP Gateway/Proxy.

Default target address To simplify testing, this address is always part of the
address list initially.

Push operation
The following operations are supported by the WapIDE push initiator:

e Push submission — send a push message to the PPG.
e Cancellation — cancel a previously submitted push message.
e Status query — request current status of previously submitted push message.

e Client capabilities query — query the PPG for the capabilities of a specific
device.

Note that Ericsson Enterprise WAP Gateway/Proxy does not support cancellation
and client capabilities query.
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For push submission, cancellation, and status query, the following can be
specified:

aplDE_3.0_PIi1

I

+1 1111111

Push ID A unique ID of the push message. It can be used to cancel or
check status on the message. WapIDE generates this ID
automatically but it can be changed by the user.

Address One or more receivers of the message. This should contain the
subscriber MSISDN number.

For cancellation and status query, this field is optional. If
omitted, the request applies to all messages with the specified
push ID.

For client capabilities query, these fields can be specified:

aplDE_3.0_PIi0
11111111

Query ID An optional identification of the query that is returned in the
response.

Application ID  An optional ID of the application in the client that will be the
target for subsequent push messages.

Address The target device address (subscriber MSISDN number).
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Push submission - advanced settings

The push submission operation has additional options that can be accessed using the
Advanced... button. Many of these are not supported by Ericsson Enterprise WAP
Gateway/Proxy (EWGP).

Puzh Meszage - Advanced 5etlings Eq

Push Message Fields

Deliver Befare eovvenn-oog: [ 2001 - &)< 7 themmssel 13256 25 nelude [0
Dieliver After tovvyennt-oog: [ 001 - 4 - 6 themmsel [ 13256 25 nelude [0

Source Reference: |

ppg-notif-requested-to:; |

prograss-notes-requested [

Quality of Service Fields

Priarity |medium ;l

Delivery Method |not5peciﬂed ;I

Metwark: | Required [
Bearer: | Required [

o |

Deliver before The date and time by which the content must be delivered to the
WAP client. The default is one day from the current time.
Check Include to add this field. Not supported by EWGP.

Deliver after The date and time after which the content should be delivered to
the WAP client. The default is the current date and time.
Check Include to add this field. Not supported by EWGP.

Source A textual name of the content provider. This is useful to a PPG

reference operator in identifying the originator of the message. Ignored
by EWGP.

Ppg-notify- The address (e.g. URL) that the PPG should use for notification

requested-to of results related to this message. Note that the WapIDE push

initiator can not receive these notifications.

Progress-notes-  Informs the PPG as to whether or not the push initiator wants to

requested receive progress notes. Ignored by EWGP.
Priority The delivery priority of the message (low, medium, or high).
Ignored by EWGP.

Delivery method The desired OTA delivery method. For EWGP, “notspecified”,
“unconfirmed”, and “preferconfirmed” all result in unconfirmed
push. “Confirmed” is not supported by EWGP.

Network The network desired for use when delivering the message. If
Required is checked, the specified network must be used.
EWGP only supports “GSM”.

Bearer The bearer desired for use when delivering the message. If
Required is checked, the specified bearer must be used. EWGP
only supports “SMS”.
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Content definition

The push message contents to be sent to the WAP client typically consists of a single
WAP SI or SL message. It may also be a multi-part message, with e.g. a WAP CO
message followed by a WAP SL message (note that multi-part messages are not
supported by Enterprise WAP Gateway/Proxy).

~Content Definitioh

Push Message | wap s1| wap sL| wap co| User defined|
~Push Message Contents

Part Content Type Content Description Content Size

1 texthnd wiap.si WiAF Service Indication 232

Delete Part | Advanced...

The Push Message tab in the content definition area contains a list of all the parts.
The other tabs are used to create parts of the message.

Add to message Use this button in the WAP SI, WAP SL, WAP CO, and
User defined tabs to create message parts.
Delete Part | Use this button in the Push Message tab to delete parts.

Advanced content settings

Additional HTTP header settings, that apply to all parts of the content, can be
accessed using the Advanced... button.

Advanced Content Settings
Additional WAP HTTP Headers

H-ap-Application-ld: |

¥-Wap-Content-UR: |

WWap-Initistar-UR: |

Ol |
X-Wap-Application-1d ~ See the WAP Push Message specification on
X-Wap-Content-URI www.wapforum.org for a description of these HTTP
X-Wap-Initiator-URI ~ headers.
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WAP SI

The Service Indication (SI) content type provides the ability to send notifications to
end-users in an asynchronous manner. Such notifications may, for example, be
about new e-mails, changes in stock price, news headlines, etc.

In its most basic form, an SI contains a short message and a URI indicating a
service.

~Content Definition

Push Message WAP I | wap sL| wisp co| User defined
—WAR Service Indication

si-id: Iu"dapIDE_SIIE Include advanced fields [
Service LIRI: |http:mﬁxap.w4.se

Message. Message text...
Add to message | Advanced ..
SIID May provide the SI with an identity in order to make it possible

to distinguish between different SIs. If not specified, it is
considered to be the same as the value of Service URI.

Service URI This attribute specifies the URI that is used to access the
service. If no service URI is specified, the SI corresponds to a
notification (no service can be initiated).

Message The text presented to the end-user upon reception.
Include Add the fields under advanced settings to the message.
advanced fields

Sl advanced settings
Using the Advanced... button, the following fields can be specified:

51 Advanced Settings Ed |

Action (priarityd |5igna|—medium

=l
Created povvynt-oog | 2001 <[ 4 -] 6 ihemmesst [ 1247 55
SiExpires  [roev-mnt-Do) | 2001 -[ -] 7 hemmessy [ 13[4 55

Sl Info Fields

Class: |

Yalue: |

Ok
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Action The action to be taken when the SI is received:

(priority)

o Signal low/medium/high — Present the message to the user.
The exact behavior for the different actions depends on the
client.

e Signal none — The SI will not be presented to the end-user.
However, the client may use the information carried in the SI
info fields to perform certain tasks.

e Delete — The received SI and any other SI with identical SI /D
will be deleted (S /D must be specified).

Created The date and time of creation or last modification of the content
indicated by Service URI.

SI expires The date and time when the SI expires and thereby is automatically
deleted or marked as “expired”. If this attribute is not specified, the
SI never expires.

Class The SI info fields provide a means to specify additional information
Value to the WAP client. Refer to WAP Service Indication on
www.wapforum.org for more information.

WAP SL

The Service Loading (SL) content type provides the ability to cause a user agent on
a mobile client to load and execute a service that, for example, can be in the form of
a WML deck.

~Content Definition

Fush Message | WaP 51 WAR SL | WP CD' Liser defined
AP Service Loading

Service URL |http:ff

Actian |execute-|uw LI

Add to message

Service URI  The URI that is used to access the service.
Action The action to be taken when the SL is received.

e Execute low/high — The service identified by the URI is loaded
(either from an origin server or from the client’s cache) and
executed. The exact behavior for the different actions depends
on the client.

e Cache - The service is loaded in the same way as above but
placed in the cache instead of being displayed in the browser.
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WAP CO

The Cache Operations (CO) content type provides a means to invalidate content
objects in the user agent cache. The invalidated content objects must be reloaded
from the origin server the next time they are needed.

There are two operations: invalidate object and invalidate service,

e invalidate object - invalidate the object uniquely identified by the given URL.

¢ invalidate service - invalidate all the objects that share the same URI prefix.

Invalidate object  The URI of the cached object to invalidate.
Invalidate service  The URI prefix of the cached objects to invalidate.

User defined

Other content types for specific applications may be added under the User defined
tab.

entiviid weap sl a

=
R

Content type Select a content type from the list or type in another content type.

Content file Enter a file name or use the - button to locate the file.
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PPG communication

The PPG communication field shows the messages sent to and responses received
from the push proxy gateway in XML format.

~PPG Communication

<rxml wersion="1.07%: :I
<\DOCTYPE pap PUBLIC "-//WAPFORUM//DTD PAP 1.0//EN" "http://wiw. wapforum
<pap:

<push-neszage push-id="WapIDE 3.0_PI/07>-
<addrezs addrezs-value="wappush=+11111111/type=plunfein.ericazon. 3e™ />

</push-messagel -
] | 5

The following colors are used for the text in the PPG communication field:

Blue  Messages sent to the PPG.
Green Messages received from the PPG.

Red  Error messages (such as HTTP errors).

Receiving push messages

The WapIDE browser can receive and display push messages in the same way as the
real devices. An exception is the push inbox function that allows you to look at old
push messages. The WapIDE browser does not support this function.

Push is currently supported by the R520m device only.

Under the Push tab in the browser trace window (see Using the browser trace on
page 20), you can see details about received push messages.

Service indication

When the browser receives a WAP SI message, a window like this is shown:

[Doumload SVT's
Dovnload SYT's

NAP-page!

| Proceed?

The text is the user message specified on the SI message (the title is the first part of
the text).

When “Proceed?” is selected, this window is shown:

Load

1 Load
2 Postone
Z Delete

Load loads the URI specified in the SI message. Delete removes the message.
Postpone is not supported since WapIDE does not store old push messages.
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Other message types

The other content types are handled in the following way:

Service loading — the specified URI is loaded and displayed in the browser
immediately.

Cache operations — these operations are not visible for the user.

User-defined — not supported by the WapIDE browser.

Pushing messages to a real terminal

You can also use the WapIDE push initiator to push messages to a real terminal
(provided that your gateway is connected to a network that supports push).

In this case, you should not reroute push messages from the gateway to WapIDE (as
described in Define receiver IP address on page 57). It is also important that a real
MSISDN is defined (see Define subscriber on page 57).

Writing applications that generate push messages

You can use WapIDE as a help in creating push applications.

L.
2.

Use the WapIDE push initiator to create the push messages you want.

Copy the XML messages from the PPG communication window and use them
as a model.

Write the application that creates the push messages and sends them to the
gateway using HTTP post. Note that you need to use HTTP basic authentication
(or a higher security) if you don’t deactivate that in the gateway.

Test the application by pushing messages to the WapIDE browser.

When the application is working, deploy it in a real environment.
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Setting up a WAP application
environment

Overview

The WapIDE browser, like a mobile phone, accesses content from a web server via a
WAP gateway. WapIDE can also read local files without a gateway. In the
following, three scenarios are described:

1. Accessing local WML files. This is an easy way to test static applications.

2. Using a gateway on the Internet. This method can be used to test applications
that are available on the Internet.

3. Using a local gateway. If you want to test local applications on a web server, or
if a firewall prevents you from using a gateway on the Internet, you have to
install a local test gateway.

Accessing local WML files

Static, local WML applications can be tested in the WapIDE browser without using
a web server or a gateway. Place your WML files on a local disk and access them
with file://path/file.wml.

Local files can use relative references to other files so you can develop an appli-
cation and then move the directory structure to a web server.

Using a gateway on the Internet

To access web servers on the Internet, you can use a WAP gateway on the Internet.
Ericsson provides a WAP gateway for external test use. Refer to the Ericsson
Developers’ Zone for more details. Note that the IP communication between
WapIDE and the WAP gateway uses UDP ports 9200 and 9201. If you have any
firewalls between WapIDE and the WAP gateway, these ports must be opened in the
firewall.
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Using a local gateway

If you want to test your own local web server applications that are not available on
the Internet, or if you are placed behind a firewall that prevents you from communi-
cating with external gateways, you need to install a local test gateway.

The local gateway can also be used to access web servers on the Internet. If your
local network is protected by a firewall you must then specify an HTTP proxy server

to use.
A
=
i
/DDD?DDD\ —
WAP gateway
‘
Firewall/ oo
Proxy server 0000000}
Web server
C ]
0]
_A0000000~_
Web server

A demo version of Ericsson’s Enterprise WAP Gateway/Proxy 2.0 can be
downloaded from the Ericsson Developers’ Zone. Refer to Installing a local
gateway on page 55 for more information.
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Configuring a web server

When you place your WAP application on a web server you have to configure it to
support the right MIME types. Refer to the documentation of your web server for
information on how to do this.

Content type MIME type File extension
WML source text/vnd.wap.wml wml
WMLScript source text/vnd.wap.wmlscript wmls
Compiled WML application/vnd.wap.wmlc wmlc
Compiled WMLScript application/vnd.wap.wmlscriptc ~ wmlsc
Wireless bitmap image/vnd.wap.wbmp wbmp

Creating dynamic WML applications

In dynamic applications, the WML decks are generated from input given by the user,
contents of a database, etc. This is typically done with JavaServer Pages (JSP), Java
servlets, Active Server Pages (ASP), or CGI scripts. Testing these applications
requires a web server with support for the chosen method.

It is important that the response content type is set correctly in the generated WML.
Here is a simple JSP example:

<% response.setContentType ("text/vnd.wap.wml"); %>
<?xml version="1.0"?>
<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.1//EN"
"http://www.wapforum.org/DTD/wml 1.1.xml">
<wml >
<card id="cardl"s>
<p>JSP test...</p>
</cards>
</wml>

In ASP, the following is used instead:

<% Response.ContentType = "text/vnd.wap.wml" %>

Managing sessions

Dynamic applications often require that the web server keeps session information,
which is usually handled with cookies. Most WAP devices do not support cookies.
Some WAP gateways (e.g. Ericsson’s WAP Gateway/Proxy) support cookies and
store them on the client’s behalf.

This means that you cannot assume that cookies are supported in the WAP
environment and that you have to use other methods for session management, such
as including a session ID in the decks (“URL rewriting”).
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Creating WMLScript applications

WMLScript is used together with WML to create WAP applications. It places some
procedural logic at the client side and thus reduces the need for communication with
the server. Typical usage is to validate user input and access function libraries
stored in the client.

To use WMLScript you must first create your own WMLScript and then call it from
a WML file, as in the following example.

<wml>
<card>
<p>Enter amount:<input type="text” format="*N" name="N"/>
<br/>
Total = $Sum
</p>

<do type="accept”>
<go href="calc.wmls#calcInterest($N,12)" />
</do>
</cards>
</wml>

The file calc.wmls contains the WMLScript code:

extern function calcInterest(N,r) ({
var Total;
Total = Lang.parseFloat (N)*(r/100+1) ;
WMLBrowser.setVar ("Sum",Float.int (Total)) ;
WMLBrowser.refresh () ;
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Installing a local gateway

This chapter describes how you install and configure a demo version of Ericsson
Enterprise WAP Gateway/Proxy 2.0. A local gateway is required for some test
configurations as described in Setting up a WAP application environment on page
51. It is also required to test push messages.

Note: The demo version of the gateway does not support WTLS. To test WTLS
applications you need access to another gateway.

Downloading and installing the gateway

A demo version of Ericsson’s Enterprise WAP Gateway/Proxy 2.0 can be
downloaded from the Ericsson Developers’ Zone (WAP -> Developers’ tools).
Refer to the instructions for installation and configuration. The gateway can be
installed on the same machine as WapIDE or on a separate machine.

Configuring the gateway for push
These configuration steps are required to test the WapIDE push functions:
e Define WapIDE as a push initiator.

e Turn off authentication (this is only required if no security is used from the push
initiator).

e Define a subscriber to receive the push messages.

o Define receiver IP address (this is necessary to reroute push messages to the
WapIDE browser).

Define push initiator

All push initiators must be defined in the gateway.

1. Select Programs » Enterprise WGP 2.0 » EWGP Provisioning from the
Windows Start menu.

2. Press Push Initiator - Create.
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a http://localhost:6060,WGPProvisioning,/LuiWgp.asp - Microsoft Internet Explorer

ﬂl'a
|x

J Fil= Edit ¥ew Favorites Tools Help

J &Back ~ = - (@ 7 | Qsearch  [GeFavorites L #Histary ||%v =]

J.ﬁ.gdress I@ http: fflocalhost: G060/ WGP Provisioning/Luitgp,asp j ﬁGo |JLinks >

WGP Provisioning

Push | 't'attorFl 1 Create - Push Initiator
ead

Delete
Content Types Pl Name|
User Agents -
Password |
Subscriber Pl Authenticated [Authenticated =

Create Read
Modify Delete

User Access fones -
4 | »

Server

Modify Delete

Pl Trusted | Trusted |~

|@ Daone l_’_ (2 Local intranet S

3. Fill in PI Name (e.g. wapide) and Password (e.g. Wapide31). The other fields
can be left as they are. Press Create.

This should create the push initiator in the gateway database and as a Windows user.

If you get the message “WIN2000 account could not be created” the installation is
probably not correctly done. Try this procedure:

1. Open Push proxy parameters as described in Define receiver IP address on
page 57.

2. In the field Domain or machine for Push initiators authentication, insert “\\”
before the machine name.

3. Restart the push service as described under Define receiver IP address.

Then delete and recreate the push initiator (delete may give error messages which
you can ignore).

Turn off authentication

Note: This step is only required if you want to use WapIDE (or another push
initiator) without HTTP basic authentication security.

1. Select Programs » Administrative Tools » Internet Services Manager from
the Windows Start menu.

Select Default Web Site and then ppgetrl and click on the right mouse button.
Select Properties from the pop-up menu.

Select the Directory Security tab.

DR

Under Anonymous access and authentication control press the Edit... button.
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Authentication Methods x|

¥ Anonymous access

Mo uzer name/pazsword required to access this resource.

Account used for anonymous access: Edi... |

—Authenticated access

For the following authentication methods, uzer name and pazsword are
required when

- ahonymous access iz dizabled, or

- access iz resticted using MTFS access control listz

[ Basic authentication [password is sent in clear text]

Select a default domain: Edit... |

[T | igest authentication for Windows damain servers

[T Integrated Windows authentication

(] I Cancel Help

Activate Anonymous access.

6
7. Press Edit... and specify the push initiator created above as anonymous user.
8. Deactivate Basic authentication.

9. Press OK twice to return to the Internet Information Services window.

10. Restart the Default Web Site. Select first Stop and then Start from the pop-up
menu.

Define subscriber

One or more subscribers to receive the push messages must be defined in the
gateway. When you reroute push messages to the WapIDE browser, it does not
matter which subscriber MSISDN number you specify. However, the address
(subscriber) you specify when you send push messages must be defined in the
gateway.

1. Start EWGP Provisioning in the same way as above.
2. Select Subscriber - Create.

3. Fill in MSISDN (e.g. 11111111), User ID, and Password. Refer to the online
help for further instructions. Press Create.

Define receiver IP address

This step is necessary to route push messages to the WapIDE browser. If you are
pushing to a real terminal you should not perform this step.

1. Select Programs » Enterprise WGP 2.0 » EWGP Configuration Tool from
the Windows Start menu.

2. Select Gateway/Proxy and then Proxy and click on the right mouse button.

3. Select Properties from the pop-up menu.
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4. Select the Push proxy parameters tab.

Pull prowy parameters.  Push proxy parameters |

— Puzh prosy gateway

Marne: Im_l,lG atewayMame

LRL: |htt|:-:.n"a"www.anUrI.-:c-m

Dramain ar machine for Puzh initiators
authentication [ prefiz for machine]:

|\\EIF‘-UDSDLI4?.|’-‘«JF|H

— EBearer gateway to use r— Push message database preferences

Emnirie |2gg|:|2 Puzh message persistence time 1440
Ot AT after delivery [minutes):

IP address: |-| 47.714.152.124 Garbage collection interval [minutes]:

Part number for incoming traffic |-| 2948 Mumber of push messages to deliver 1000
from the bearer gateway: before mezzage status update:

M ax Fush messages per second
to the bearer gateway:

M aximum number of push messages 1000
ta read from database:

Push message queus size: 5000
— Stack preferences

|1 oo
WOP port number: |2943 Retry time after database ermar £0000

ocounence [ms):

T

Retry time when na push messages 10000
—Push message delivery preferences————————————————— in database [ms]:

HTTF POST baody maimun size Imgugg
[bytes]:

Ok I Cancel | Apply | Help

5. Under Bearer gateway to use, enter 29002 for Port number and the address of
the WapIDE machine for IP address. Make a note of the previous values if you
want to use the gateway for pushing to real terminals later.

For the changes to take effect, the push service must be restarted:

1. Select Programs » Enterprise WGP 2.0 » EWGP Node supervisor client
from the Windows Start menu.

2. Press Show Details.

3. Restart the Push Delivery Service by first selecting Stop Service and then
Start Service from the pop-up menu.
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Appendix A: Device limitations

The objective of WapIDE is to simulate the real WAP devices as realistically as
possible. This chapter describes optional WAP functions not supported by the
Ericsson devices (and therefore not by WapIDE), and areas where WapIDE does not
work exactly like the real devices.

Devices supported
The following devices are currently supported by WapIDE:

Device WAP release  Push  UAProf

R320s 1.1
R380s 1.1
R520m 1.2.1! N N

There are also Chinese versions of these devices (for example, R320sc is the
Chinese version of R320s). These versions are partly supported since Chinese
characters can be displayed in the device and entered from the computer keyboard.
However, Chinese characters can not be entered using the buttons on the device.

Optional WAP features not supported
These optional and new features are not supported (i.e. ignored) by the real devices:
e The optgroup (R320s only), fieldset (R320s and R520m), and pre elements.

e The align, height, width, hspace, vspace, and localsrc attributes on the image
element (R320s and R520m).

e The tabindex attribute on e.g. select and input elements.

e The big and i elements on R320s and R520m (displayed as bold and normal font
respectively).

e Theiand u elements on R380s (displayed as bold font).

UWAP 1.2.1 is also known as the June 2000 conformance release.
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Functions not supported by WapIDE

These functions are not supported or work differently in WapIDE.
e R320s and R520m:

There are no scroll indicators that indicate whether the window can be
scrolled up or down or not.

In the real devices, when an input window is opened, a text with “abc” or
“123” is shown briefly to indicate the format of the input field. WapIDE
does not show this text.

The maxlength attribute on input fields is not supported.

The progress indicator that indicates that a URL is being loaded is not
shown in the device display but in the toolbar (rotating globe).

Long options are truncated instead of scrolled sideways.

The optgroup element is ignored (R520m).

o R380s:

Long values in input fields are truncated instead of wrapped on multiple
lines.

The layout of options in a multiple select element is different in some cases.
Long options are not wrapped and a right aligned multiple select looks
slightly different.

Image alignment is different when there are multiple images or buttons with
different alignment on the same row.

WMLScript confirm dialogs are not scrollable.

The hspace and vspace attributes on the image element are not supported.

o General:

Characters entered in password fields are not shown as asterisks.

The soft hyphen character entity (&shy; or &#173) is ignored.

The maximum size of an image that can be downloaded is different.

In Chinese mode, western characters are larger than in the real devices.

The WTAI and Crypto WMLScript libraries are not supported.
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Glossary of terms

Bookmark

Card

Character
Encoding

Client

Content

Content
Encoding

Cookie

Deck

Device

DTD

HTTP

JavaScript

WapIDE User's Guide

A named reference to a URL. Enables the user to keep track of
favorite pages and then return to them, easily, later on.

A single WML unit of navigation and user interface. May contain
information to present to the user, instructions for gathering user
input, etc.

Conversion between a sequence of characters and a sequence of
bytes and vice versa. Normally, WML document character
encoding is captured in transport header attributes such as the

Content-Type’s “charset” parameter, meta information placed
within a document, or the XML declaration.

A device (or application) that initiates a request for connection
with a server.

Subject matter (data) stored or generated at an origin server.
Content is typically displayed or interpreted by a user agent in
response to a user request.

Conversion of content from one format to another. Typically the
resulting format requires less physical space than the original, is
easier to process or store, and/or is encrypted. It is can also
specify a particular format or encoding standard or process.

A cookie is a small piece of information that an HTTP server
sends to a browser when the browser connects for the first time.
Thereafter, the browser returns a copy of the cookie to the server
each time it connects. Typically the server uses the cookie to
maintain a session for the user.

A collection of WML cards. A WML deck is also an XML
document.

In this document, used as a synonym for terminal.

A document type definition (DTD) is a collection of declarations
that defines the legal structure, elements, and attributes that are
available for use in an XML document that complies with the
DTD.

The Hypertext Transfer Protocol is the client/server protocol that
defines how messages are formatted and transmitted on the World
Wide Web.

A de facto standard language that can be used to add dynamic
behaviour to HTML documents. JavaScript is one of the
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originating technologies of ECMAScript.

The server on which a given resource resides or is to be created.
Often referred to as a web server or an HTTP server.

An HTTP server, typically running on a firewall machine, that
provides access to the outside world for clients on a local
network.

A network data object or service that can be identified by a URL.

A device providing the user with user agent capabilities, including
the ability to request and receive information. Also called a
mobile terminal or mobile station.

User agent profiles specify device characteristics that are used by
the origin server for content formatting purposes.

A universal character encoding scheme for written characters and
text. It defines a consistent way of encoding multilingual text that
enables the exchange of text data internationally. Unicode
provides for two encoding forms: a default 16-bit form and a
byte-oriented form called UTF-8.

A Uniform Resource Locator is an address identifying the
location of a file on the Internet, consisting of the protocol, the
computer on which the file is located, and the file's location on
that computer.

A user agent is any software or device that interprets WML,
WMLScript, WTAI or other resources. This may include textual
browsers, voice browsers, search engines, etc.

A WAP gateway converts between the WAP protocol stack
(WSP, WTP, and WDP) and the WWW protocol stack (HTTP
and TCP/IP), and performs encoding of WML and WMLScript.

This is an acronym for Ericsson’s Wireless Application Protocol
Integrated Development Environment.

The Wireless Markup Language is a hypertext markup language
used to represent information for delivery to a narrowband device,
e.g., a phone.

A scripting language used to program the mobile device.
WMLScript is an extended subset of the JavaScript scripting
language.

Wireless Telephony Application. A framework for accessing the
telephony related functions in a mobile terminal.

Wireless Transport Layer Security. A security protocol based
upon the industry-standard Transport Layer Security (TLS)
protocol, formerly known as Secure Sockets Layer (SSL).

The Extensible Markup Language is a World Wide Web
Consortium (W3C) standard for Internet markup languages, of
which WML is one such language.
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